# 2015 User Conference ArcGIS for Desktop Q&A

## Table of Contents

### ArcMap Section

<table>
<thead>
<tr>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s new in ArcMap 10.3 and 10.3.1?</td>
<td>3</td>
</tr>
<tr>
<td>What did you do to improve ArcMap at 10.3.1?</td>
<td>3</td>
</tr>
<tr>
<td>How long will ArcMap be supported and enhanced?</td>
<td>4</td>
</tr>
<tr>
<td>What’s planned for the next release of ArcMap?</td>
<td>4</td>
</tr>
<tr>
<td>Are there any new tools being added to the Geostatistics Analyst extension?</td>
<td>4</td>
</tr>
<tr>
<td>What are the new ArcMap improvements coming in 10.4?</td>
<td>4</td>
</tr>
<tr>
<td>What’s the future of ArcObjects?</td>
<td>4</td>
</tr>
<tr>
<td>What are you doing to improve quality in ArcMap?</td>
<td>4</td>
</tr>
<tr>
<td>Can I share my crash reports with Esri?</td>
<td>5</td>
</tr>
<tr>
<td>What is Esri doing to address these issues?</td>
<td>5</td>
</tr>
</tbody>
</table>

### ArcGIS Pro Section

<table>
<thead>
<tr>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is ArcGIS Pro a replacement for ArcMap?</td>
<td>6</td>
</tr>
<tr>
<td>What are the system requirements for ArcGIS Pro?</td>
<td>6</td>
</tr>
<tr>
<td>What is ArcGIS Pro now?</td>
<td>6</td>
</tr>
<tr>
<td>What is the Vision for ArcGIS Pro in the future?</td>
<td>6</td>
</tr>
<tr>
<td>What is the road ahead for ArcGIS Pro?</td>
<td>6</td>
</tr>
<tr>
<td>How hard is it to learn Pro?</td>
<td>7</td>
</tr>
<tr>
<td>How do you activate ArcGIS Pro?</td>
<td>7</td>
</tr>
<tr>
<td>Do I need an ArcGIS Online account?</td>
<td>7</td>
</tr>
<tr>
<td>Can ArcGIS Pro be assigned \ re-assigned to different people in my organization?</td>
<td>7</td>
</tr>
<tr>
<td>What if I’m unable to renew my ArcGIS for Desktop maintenance?</td>
<td>7</td>
</tr>
<tr>
<td>Is there current-use licensing for ArcGIS Pro?</td>
<td>7</td>
</tr>
<tr>
<td>On how many machines can I use ArcGIS Pro?</td>
<td>8</td>
</tr>
<tr>
<td>Can I take my ArcGIS Pro license offline?</td>
<td>8</td>
</tr>
<tr>
<td>Do analysis services and new tools like Enrich Layer use ArcGIS Online service credits?</td>
<td>8</td>
</tr>
<tr>
<td>What are the new capabilities in space-time pattern mining in ArcGIS?</td>
<td>8</td>
</tr>
<tr>
<td>How does ArcGIS Pro work with ArcGIS for Server?</td>
<td>8</td>
</tr>
<tr>
<td>How does ArcGIS Pro work with Portal for ArcGIS?</td>
<td>8</td>
</tr>
</tbody>
</table>
Is there a way to set my folder and database connections, without doing it manually for each project?

How do I remove recent projects from the start page?

How can I migrate my existing GIS work into ArcGIS Pro?

How to save Custom Coordinate system as Favorites in ArcGIS Pro?

How to add locators to a project in ArcGIS Pro?

Is it possible to create .lyr and .lpk files in Pro?

How do I share a map authored in ArcGIS Pro with someone using ArcMap?

Can Tasks be converted to Python scripts?

Why is PDF export file size so large?

Is it possible to "Add [output] to Display" when running a model in ArcGIS Pro?

How do I access the Help library if I decide to work offline?

Why is the Infographics tool grayed out, if I'm logged into my licensing portal?

Does ArcGIS Pro connect to multiple Portals?

Will my Python scripts work in Pro?

How do you customize ArcGIS Pro?

Will my existing Python scripts work in ArcGIS Pro?

In what languages is ArcGIS Pro available?

ArcMap Section

What’s new in ArcMap 10.3 and 10.3.1?
ArcMap 10.3 is part of a full release cycle and has many new features; 10.3.1 builds on these:


Most noteworthy are probably the improvements in data management to provide geoprocessing tools for enterprise geodatabase management, support user licensing of file geodatabases, support for suggestions when interactively geocoding, many new raster functions and optimized LAS data support, but there is something for everyone.

What did you do to improve ArcMap at 10.3.1?
ArcMap 10.3.1 was a minor update to ArcMap. However, it did include many quality improvements as well as some noteworthy enhancements including:

- New geoprocessing tools for working with LAS data sets
- Additional tools for managing your enterprise geodatabases
- Support for additional CAD export parameters
- Additional parameters and properties for many geoprocessing tools
- Addition of the Viewshed2 tool in the 3D Analyst extension
- A new tool for creating training samples in the Spatial Analyst extension

For a complete list see the **What's new in ArcGIS 10.3.1 for Desktop** page:


**How long will ArcMap be supported and enhanced?**

ArcMap is being actively developed and enhanced. We have published the life-cycle support for ArcGIS Desktop here. [http://downloads2.esri.com/support/TechArticles/ProductLifeCycle.pdf](http://downloads2.esri.com/support/TechArticles/ProductLifeCycle.pdf)

As you can see, ArcMap 10.3 will be supported for several years and we are already working on a version 10.4 and 10.4.1 of ArcMap. You should feel secure in using ArcMap today and in the future for your desktop GIS work.

**What’s planned for the next release of ArcMap?**

The next release of ArcMap will be version 10.4 and focus on

- Raster Processing
- New Geoprocessing Tools
- Updates to the ArcObjects SDK to support .NET 4.5 and latest versions of Visual Studio
- Improved Accessibility (508 compliance)
- And More

**Are there any new tools being added to the Geostatistics Analyst extension?**

We are very excited to include the new Empirical Bayesian Kriging Regression tool in Geostatistical Analyst extension for the next ArcGIS for Desktop release. EBK Regression Prediction is an interpolation method that improves kriging predictions by incorporating regression methodology. The regression component provides additional information about the variable you want to interpolate; therefore, combining regression with kriging can produce better predictions than either method individually. For example, prediction of temperature is improved by incorporating elevation into the interpolation because temperature depends heavily on elevation. Historically, kriging has been most frequently used in geology and environmental sciences, but this new approach extends kriging to other applications such as land valuation and prediction of sales revenues.

**What are the new ArcMap improvements coming in 10.4?**

There are quite a few plans for ArcMap 10.4. We are going to add additional Geoprocessing Tools to continue to expand our support geographic science. We have plans for new imagery and raster functionality. We are making improvements with regard to ArcObjects and the SDK by moving ahead to Visual Studio 2013/2015 and .NET Framework 4.5. At the same time we continue to improve accessibility (in the US this means continuing to meet section 508 compliance). Under the hood we have been making updates and architectural changes to ensure ArcMap 10.4 can continue to be supported well into the future.

**What’s the future of ArcObjects?**

ArcObjects continues to be the most advanced method for customizing and extending ArcMap. Just as ArcMap will continue to be supported for the foreseeable future, so will ArcObjects. At version 10.4 we will be making some important improvements to the ArcObjects SDK. We are updating the .NET Framework support to version 4.5 and adding support for Visual Studio 2013/2015.

**What are you doing to improve quality in ArcMap?**

We working hard to fixed issues that we find in testing and that you report via Esri Technical Support. Over the last year we have dedicated some resources on fixing bugs and the result is that we addressed 565 issues at version
10.3 and another 262 issues in 10.3.1 release. We plan to continue testing and fixing issues so if you experience a problem, please contact Technical Support.


Can I share my crash reports with Esri?

While there are a varying degree of potential environmental variables that can impact the stability of any software, such as system resources, 3rd party software conflicts, profile corruption, etc. there are also times that an application crashes due to unforeseen bugs in the code. Regardless of the scenario, we understand that this is extremely frustrating for you and it is for us too. This is why we have specific processes in place that enable users to share their crash reports with Esri, so that we can improve the quality of the software and identify issues that we might otherwise have no other means of tracking down. ArcGIS for Desktop applications are capable of capturing software crash data as part of the Esri User Experience Improvement program (EUEI). Click here for more EUEI details.

As the conditions that lead to these crashes are often not easily reproducible, Esri has instrumented our Desktop software with the ability to collect the software state on your computer prior to the software shutting down. When a serious application error occurs, users are provided the option to report these crashes to Esri via email and in doing so help Esri to identify, track and repair critical issues. Also, once a critical crash has been identified by the error reporting system and a fix is delivered by Development, if a user reports a critical crash by email, our Customer Advocacy team will notify the user that a fix is available. Therefore, it is highly encouraged to send all your error reports to Esri, but also to include a valid email address so that we may contact you when there's a fix or to glean more information around the issue you're experiencing.

What is Esri doing to address these issues?

The Error Report we receive from you includes important and detailed information that often enables us to repair problems that we have no other means of tracking down. Many of these errors cannot be easily reproduced. These types of errors occur in many situations with complex configurations or very specialized data formats, and situations in which third party software components are used in concert with ArcGIS.

The content of the Error Report that you send to ArcGISErrorReport@esri.com provides the Esri Development team with insight into how to better engineer the software to avoid these errors in the future. And most importantly, this enables Esri to repair and include more fixes in the next release of ArcGIS for Desktop improving both stability and quality of the software.
ArcGIS Pro Section

Is ArcGIS Pro a replacement for ArcMap?
No, Pro is an additional application you get with your Desktop license, you do not need to stop using ArcMap. While ArcGIS Pro is a new application with some different features, ArcMap remains the fully supported and the most advanced desktop GIS application. ArcGIS Pro currently does not have all the capabilities of ArcMap and it will take several releases of Pro to catch up to ArcMap. We are not asking you to migrate your work away for ArcMap just because we released Pro. However we encourage you to become familiar with ArcGIS Pro as it might be used more in the feature for your map authoring, editing and analysis workflows.

What are the system requirements for ArcGIS Pro?
Please see this link:
http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-system-requirements.htm

ArcGIS Pro is new application and requires newer more modern hardware. We have documented the required and the recommended configuration and provide a utility to test out your machine before installing ArcGIS Pro.

What is ArcGIS Pro now?
ArcGIS Pro is a strong tool for visualization in both 2D and 3D, analysis containing the vast majority of the geoprocessing tools, mapping with advanced symbology and transparency, and sharing through packages and web maps and scenes. It is also a modern application that takes advantage of all the modern hardware you have on your desktop including 64-bit and multi-threaded processing. Even with all of these strengths, it is a first release and there is much more to come.

What is the Vision for ArcGIS Pro in the future?
ArcGIS Pro is the next generation ArcGIS desktop application for the GIS community who need a clean and comprehensive user experience which is incredibly fast and efficient, and that will increase productivity for integrated 2D and 3D workflows supporting visualization, data management, and spatial analysis.

What is the road ahead for ArcGIS Pro?
ArcGIS Pro represents Esri’s strategy for creating a modern GIS desktop that tightly integrates with the rest of the ArcGIS Platform. ArcGIS Pro was released in January (Version 1.0) as a strong tool for visualization, supporting both 2D and 3D; analysis, containing the vast majority of the geoprocessing tools; mapping, with advanced symbology and transparency; and sharing through packages, web maps and web scenes.

We have continued to build upon the strong foundation of ArcGIS Pro and in early July, Esri will release Version 1.1 which has many enhancements including the following:

- A new SDK for .NET to customize and extend ArcGIS Pro
- A Range Slider that allows you to dissect and visually analyze your numeric data
- The ability to publish 3D scenes containing multipatches
- Layout enhancements, like guides and snapping and the ability to add extent indicators
- Support for working with Excel tables directly
- Date line wrapping allowing you to pan, edit, and work across the international date line

There are many more enhancements in version 1.1 related to geoprocessing, imagery and raster, 3D Analyst, Network Analyst, and Workflow Manager. There are also two new extensions coming with version 1.1 including the Data Interoperability Extension and StreetMap Premium.
We envision that in the fourth quarter of 2015, we will release version 1.2 with even more capabilities including:

- Strong KML support
- The ability to publish and use vector tiles
- Mobile Map Packages for deployment on all your devices
- Additional 3D Web Scene capabilities
- Support for Topology
- Data Driven Pages
- The ability to create Animations
- Charts and graphs

The ArcGIS Pro releases coming in 2016 will focus on support for some major solutions including Utility Management, Parcel Management, and Transportation and Pipeline (Linear Referencing). We will also continue to enhance our cartographic, imagery, and analysis capabilities.

**How hard is it to learn Pro?**

While the interface is different from ArcMap, many of the concepts are the same and it is still familiar enough to existing users, that we find they are able to pick up and begin using ArcGIS Pro quickly. Within a few days they are using Pro in conjunction with ArcMap, exercising many of the new capabilities that are available. For users who want some help, we offer a free Web course, Getting Started with ArcGIS Pro, which is designed to jump start anyone who is already proficient with ArcMap. We also offer a two day, instructor led training course, Introduction to ArcGIS Pro for GIS Professionals, for those who want to dig deeper. We see ArcGIS Pro becoming an essential element of the GIS professionals’ toolbox for enabling and supporting the whole world of Web GIS.

**How do you activate ArcGIS Pro?**

To activate Pro you must contact customer service and have them activate your organization with ArcGIS Pro licenses. Then an administrator of your organizations licenses needs to assign licenses to individual named users within the organization. This can be either through Portal or ArcGIS Online.

**Do I need an ArcGIS Online account?**

You need a named user account either through Portal or ArcGIS Online.

**Can ArcGIS Pro be assigned \ re-assigned to different people in my organization?**

There are no technical restrictions to the number of times an ArcGIS Pro entitlement is reassigned, but the spirit of the license is that the user of ArcGIS Pro is also a licensed user of ArcGIS for Desktop (ArcMap).

**What if I’m unable to renew my ArcGIS for Desktop maintenance?**

If you do not renew your ArcGIS for Desktop maintenance, you will continue to be able to use ArcMap, but no longer be able to access ArcGIS Pro after the expiration of the maintenance term.

**Is there current-use licensing for ArcGIS Pro?**

ArcGIS Pro is a gateway to Web GIS (among other things) and uses a named user to control access to the software and any content contributed to the cloud under your unique identity. The license can be assigned and re-assigned as needed, but the concept of concurrent use does not match with unique identities. This is different from the concurrent use licensing used by ArcMap.
On how many machines can I use ArcGIS Pro?
When connected to ArcGIS Online, or your Portal you can log in on up to 3 machines at the same time. If you are disconnected and have your license set to work offline you can work with the one machine that has been taken offline.

Can I take my ArcGIS Pro license offline?
Yes, you can take your ArcGIS Pro license offline and use it with no connectivity until the date your Desktop maintenance or ArcGIS Online subscription expires. However, you may not need or want to do this. See this blog post for additional information.

Do analysis services and new tools like Enrich Layer use ArcGIS Online service credits?
Yes. ArcGIS Pro also includes a new geoprocessing tool Enrich Layer, which enables you to add demographic, landscape, and community tapestry information to your GIS data. This tool consumes credits. In addition, using the drive-time and drive-distance measurement options in the new tool Summarize Nearby costs service credits.

In ArcGIS Pro you can connect to and use several ready-to-use analysis services and content, including:

- Demographic and lifestyle maps
- Infographics
- ArcGIS Online World Geocoding service
- Network Analysis service
- Elevation Analysis and Hydrology Analysis Service

These services make it easy to perform analysis without needing to search for or prepare data. For example, you can get street network routing without needing your own Network Analyst dataset, or perform a Viewshed analysis without needing to download and prepare a DEM for your study area. These services consume credits.

For more information about ArcGIS Online service credits, check here.

What are the new capabilities in space-time pattern mining in ArcGIS?
Since we added the Space Time Pattern Mining toolbox to ArcGIS for Desktop 10.3 and ArcGIS Pro 1.0, it has been enhanced in several ways. Create Space Time Cube has added functionality to handle marked points. Numeric attributes associated with incident points can now be aggregated into the bin structure of a space-time cube and used in Emerging Hot Spot Analysis. New utility tools have also been added to the Space Time Pattern Mining toolbox that can be used to visualize the various variables in your space-time cube in both 2D and 3D.

How does ArcGIS Pro work with ArcGIS for Server?
ArcGIS Pro can connect to an ArcGIS Server site and access its web services.

In terms of publishing, ArcGIS Pro is designed to be the premier client app that works with an ArcGIS portal, which could be either ArcGIS Online or Portal for ArcGIS. When you share GIS content from ArcGIS Pro, it publishes to a portal and not directly to an ArcGIS Server site.

How does ArcGIS Pro work with Portal for ArcGIS?
ArcGIS Pro can sign into any ArcGIS portal, which could be either ArcGIS Online or Portal for ArcGIS. After signing into a portal, it can read and access any content that is available to the ArcGIS identity used to sign into the portal. After signing into a Portal instance, ArcGIS Pro can also publish and share GIS content to Portal for ArcGIS as a hosted web layer or hosted tile layer.
In addition, you can also leverage Portal for ArcGIS to manage and administer your ArcGIS Pro licenses within your organization, instead of using ArcGIS Online.

**How does Portal for ArcGIS manage and administer your ArcGIS Pro licenses?**

Portal for ArcGIS can be used along with ArcGIS License Manager to manage your ArcGIS Pro licenses within your organization, in your own infrastructure. This is ideal for organizations who may want to work in a disconnected environment. The user experience for administering and managing ArcGIS Pro licenses in the same as if you were managed them in ArcGIS Online. Learn more by reviewing these help topics:

- Configure ArcGIS Pro licenses
- Manage ArcGIS Pro licenses

**For sharing/publishing GIS content workflows is ArcGIS Pro a replacement for ArcMap?**

No, ArcGIS Pro is not a replacement for ArcMap. Both Desktop applications are different and offer different capabilities. ArcMap is the ideal solution for publishing and sharing many common GIS content as web services. Its service editor provides many options to set and configure web service properties to publish to ArcGIS for Server and an ArcGIS Portal (ArcGIS Online or Portal for ArcGIS).

ArcGIS Pro is designed to be the premier client app that works with an ArcGIS portal, which could be either ArcGIS Online or Portal for ArcGIS. When you share GIS content from ArcGIS Pro, it publishes to a portal and not directly to an ArcGIS Server site. Another differentiator is that ArcGIS Pro enables you to easily share your 3D data content to an ArcGIS portal.

**What can I do to ensure that I’m getting the best performance from my Basemaps?**

There are potentially many things that can affect connecting and performance of Basemaps in ArcMap or any other App. These include network speed, firewalls, access to a local cache folder, antivirus software and others. The following blog post provides steps to help you track down issues if you are having trouble connecting or experiencing poor performance with Esri Basemaps:


As always, you can contact technical support and they will be happy to help you track down any issues related to performance with Basemaps.

**How do I Apply ArcGIS Pro Software Updates?**

Users will receive update notification messages inside the application that tell them an update is available for install. These notifications are not to be confused with an automatic update— they simply prompt users to run the install if they choose, or dismiss the update process until they’re ready to install. Check out the following blog for the technical details of applying updates in Pro: [How to Apply ArcGIS Pro Software Updates](http://blogs.esri.com/esri/supportcenter/2013/04/01/having-issues-adding-arcgis-online-basemaps-to-arcmap/)

**Is it possible to block update notifications in ArcGIS Pro, so that end-users are unable to install updates from within the application?**

Yes. For system administrators who would like to block users from installing software updates inside the ArcGIS Pro application, it is possible to do so by making changes to the Windows Registry. These changes prevent ArcGIS Pro from searching for updates, block notification messages that appear to users on startup, and hide updates otherwise listed on the About page inside the application. For the details, see Knowledge Base article 44630.

**Is ArcGIS Pro supported in virtualized environments?**

Yes, ArcGIS Pro is supported in the virtual environments Citrix, VMware, and Hyper-V. For more details on running Pro in these environments, check out the blogs, [ArcGIS Pro in virtualized environments](http://blogs.esri.com/esri/supportcenter/2013/04/01/having-issues-adding-arcgis-online-basemaps-to-arcmap/), [Virtualizing ArcGIS Pro: Nvidia Grid vGPU Profiles](http://blogs.esri.com/esri/supportcenter/2013/04/01/having-issues-adding-arcgis-online-basemaps-to-arcmap/) and [ArcGIS Pro with NVIDIA K1 in XenDesktop](http://blogs.esri.com/esri/supportcenter/2013/04/01/having-issues-adding-arcgis-online-basemaps-to-arcmap/).
**Does ArcGIS Pro virtualize?**
Yes. ArcGIS Pro virtualizes well. The great user experience that is available on a physical desktop can also be delivered on a virtual desktop. This includes all of the major virtualization environments, VMWare Hyper-V, Citrix XenDesktop, and Microsoft Hyper-V. To deliver that user experience the virtualization environment will need a shareable GPU such as an Nvidia GRID K2 card. Additional info will be provided in Best Practice documentation that is being prepared now. Several blogs on this topic are available now, more are coming.

http://blogs.esri.com/esri/arcgis/2015/05/28/49638/

**Who should I contact at Esri if I need to run ArcGIS Pro in a closed network environment?**
Reach out to your Esri Account Manager for more details on your options for running ArcGIS Pro offline.

**How do I assign ArcGIS Pro licenses to users in ArcGIS Online?**
As the Online admin for your org, you can assign ArcGIS Pro licenses to users by logging into your organization and clicking the Manage Licenses button. For more details, see the help topic Manage ArcGIS Pro licenses.

**The Manage Licenses button is not displayed in my ArcGIS Online (or Portal) organization. How do I get access to ArcGIS Pro licenses?**
If you are current on DT maintenance, you are entitled to ArcGIS Pro licenses. If you do not see a Manage Licenses tab in your ArcGIS Online or Portal organization, please reach out to your customer service representative for assistance.

**Is it possible to assign/revoke ArcGIS Pro licenses for multiple users at a time?**
Yes, it is possible to configure licenses for multiple members of your organization, by applying updates to a Selected Members list. For the steps, see the help topic Manage ArcGIS Pro licenses.

**Who in my organization can run ArcGIS Pro?**
Any Portal or ArcGIS Online named user assigned a Pro license within your organization, can run ArcGIS Pro from up to three machines.

**Is ArcGIS Pro available for ArcGIS for Home Use users?**
Yes, Home Use customers are entitled to ArcGIS Pro.

**I’m trying to login to ArcGIS Pro and I receive the error, “The account could not be used to sign in because it is not authorized to use ArcGIS Pro.” What does this mean and what should I do?**
If the proper named user credentials are being entered, this error can indicate that an ArcGIS Pro license has not been assigned to you by your Portal or ArcGIS Online administrator. Reach out to your admin to request a license and if the error persists, you can always contact Technical Support for more help. For the things you need know to get started with ArcGIS Pro, check out the following video. Also, review ArcGIS Pro licensing Information once logged in.

**I receive a “Timestamp Invalid” error when attempting to sign in to ArcGIS Pro.**
Your system clock has to be within one hour of your ArcGIS Online or Portal server clock to activate ArcGIS Pro successfully, otherwise a "Timestamp Invalid" error will be generated. To properly set your system clock:

1. Set your clock to your correct time zone
2. Select to "Automatically adjust clock for Daylight Saving Time"
3. Adjust the time on the clock to the correct time (if needed)
If a user takes a license offline, can the administrator still revoke it?  
No, once an ArcGIS Pro license is taken offline by a user, this disables the admin's ability to revoke the license. However, there are ways that help an admin keep track of licenses for their org. They can encourage all users to set aliases for their machines, so that the admin can determine from the Manage Licenses page inside of ArcGIS Online, which machine is storing the license offline (see the review ArcGIS Pro licensing information help topic for details on setting machine aliases). Usernames marked with red on the Manage Licenses page, indicate the license is offline. If an admin can see which machine the license is offline, they can reach out to the user and request the license be returned to the org and from which machine.

I'm trying to take my license back online, but the option to do so is grayed out.
In order to return an offline license back to your licensing portal, you must be signed into the organization that checked out the license. Click Portals on the Project tab, find the portal displaying the gray key symbol (your licensing portal) and right-click. Choose Sign in and provide your credentials. Click Licensing on the Project tab and notice that the "Authorize ArcGIS Pro to work offline" checkbox is now enabled and can be unchecked. Unchecking this option will return the offline license back to your licensing portal. You will be required to sign into your licensing portal once more to proceed.

How do I change my licensing portal?
When you start ArcGIS Pro, you are signing in to your licensing portal, which is the server that controls software authorizations for your account. In many cases, the licensing portal is the same one you use to share content with others. However, some sites may set up a licensing portal that is separate from the portal containing the organization's maps and other data. You can enter a different licensing portal URL when you start ArcGIS Pro. You can only change the licensing portal when you first start ArcGIS Pro. While you are using the application, you cannot switch to a different licensing portal, so will need to close and restart ArcGIS Pro to do this. You can view the available portals on the Project tab.

1. Start ArcGIS Pro.
2. Click Configure your licensing portal on the window that prompts you to sign in.
3. Type in the URL for the licensing portal.
4. Click OK.
5. Sign in with your licensing credentials.

What happens if I lose internet connection and my ArcGIS Pro license is Online?
Should you lose internet connection, ArcGIS Pro will remain open for 24 hours before closing. This means that you can continue working and save your work, even if your internet connection goes down.

When is support for Geometric Networks coming in ArcGIS Pro?
It is currently possible to view and query geometric networks within ArcGIS Pro 1.0. However, it isn't yet possible to edit or trace them. These capabilities are planned for a future release of ArcGIS Pro.

Is it possible to edit Topology in ArcGIS Pro?
At ArcGIS Pro 1.0, it is currently possible to edit the feature classes that participate in a topology and view topology classes in the Contents pane. It is not yet possible to add a topology layer to your map, create or modify topology classes, or validate/fixed topology errors. This functionality is planned for future releases of ArcGIS Pro.

Will my ArcObjects application built for ArcGIS Desktop work in ArcGIS Pro?
No, the new application has a brand new .NET API and the functionality and workflows in many instances are different from what exists in ArcMap. The new API is built using ArcObjects; however, ArcObjects is not being exposed directly. The new API is much simpler and developer friendly, providing a better developer experience,
allowing you to include more functionality with less code. For more details on ways to extend or enhance ArcGIS Pro, check out this blog.

Does ArcGIS Pro support SQLite?
SQLite is not yet supported in ArcGIS Pro 1.0, but will be coming in a future release.

Does ArcGIS Pro support CAD files?
In the release of ArcGIS Pro 1.0, CAD files are supported in the same way as ArcMap. CAD files are used as native GIS datasets for layers in the map, and input to geoprocessing tools. Automatic rendering of the map layers used to mimic CAD symbols is currently only supported in ArcMap.

Does ArcGIS Pro support KML?
Import and export KML geoprocessing tools are available in ArcGIS Pro 1.0. Native 2D KML support and the ability to connect to 2D KML services, as well as 3D support, is planned for a future release of ArcGIS Pro.

Is it possible to add Excel tables to ArcGIS Pro?
Direct read of Excel tables in ArcGIS Pro is not currently possible, but on its way in a future release. It is currently possible to run the Excel to Table geoprocessing tool to convert the Excel file into a .gdb table.

How to connect to Microsoft Access (.accdb) tables and/or personal geodatabases (.mdb) in ArcGIS Pro?
Microsoft Access tables and personal geodatabases are not supported in ArcGIS Pro.

Are all the geoprocessing tools from ArcMap in ArcGIS Pro?
The majority of geoprocessing tools that are available in ArcMap are also available and working in ArcGIS Pro. Check out this blog for more geoprocessing frequently asked questions.

How to change the default location for creating and storing new projects in ArcGIS Pro?
By default new projects are created in the My Documents\ArcGIS\Projects folder in the user profile directory. To store projects in another location, you change the Default Folder property. Open the application and choose the Project tab. Then choose Options and click General to select the, "Create new projects in another local or network folder." Browse to the desired folder, and click Select.

Is there a way to set my folder and database connections, without doing it manually for each project?
With ArcGIS Pro 1.0, it is possible to create a project template that includes connections to databases and folders, from which new projects can be created. For more details, see the help topic Create a project template

How do I remove recent projects from the start page?
Currently, there is no user interface in the application which allows you to reset user settings to defaults. This is something that our application framework team is considering for future release. However, you can perform the following steps to achieve this:

1. Browse to the following location on your machine: %localappdata%\ESRI\ArcGISPro.exe.Url_1\clabdb3g2held3u2vbbtsyiwtjlkq\11.0.0.0\user.config
2. If you find this file, application will re-create it upon next start and the list of recent projects should now be empty

How can I migrate my existing GIS work into ArcGIS Pro?
It is possible to import existing files from the Project pane or Insert tab as outlined in the following help topic, Migrate your work to ArcGIS Pro
How to save Custom Coordinate System as Favorites in ArcGIS Pro?
Go to Map Properties by right clicking a map in the Contents pane. Choose Coordinate System and expand the Layers options. Right-click on the desired coordinate system and Add to Favorites. You can also move desired .prj files to the following location: C:\Users\username\AppData\Local\ESRI\ArcGISPro1.0\Favorites. Once the .prj files are in the Favorites folder, they will be listed under the Favorites tab in the Map Properties dialog.

How to add locators to a project in ArcGIS Pro?
It is possible to add locators to your project from the Insert tab > Connections > Add Locator. When an address is searched using the Locate pane, all locators added to the project will be searched for finding possible matching candidates. For more details, see the help topic Add locators to a project.

Is it possible to create .lyr and .lpk files in Pro?
No, ArcGIS Pro saves .lyrx and .lpkx files which are not consumable by ArcMap, as not all Pro functionality is compatible with ArcMap.

How do I share a map authored in ArcGIS Pro with someone using ArcMap?
While map documents cannot be shared between the two applications, it is still possible to share and collaborate in several ways. The data if using geodatabases, shapefiles, or other supported formats can be shared between applications and maps can be published as services from ArcGIS Pro and shared with someone using ArcMap, ArcGIS Online, or Portal for ArcGIS.

Can Tasks be converted to Python scripts?
Tasks in ArcGIS Pro are designed for interactive workflows. They cannot be converted to Python scripts. To read more about tasks, see this link.

Why is PDF export file size so large?
ArcGIS Pro utilizes an Esri designed GDI instead of the Windows GDI. This impacts the way that PDF files are created. The drawing of raster and transparency layers as well as vector features has changed, and resulting shapes and trajectories of vector features are drawn much closer to their original geometry. Thus producing larger file sizes, because a lot more information is placed in the PDF.

Is it possible to "Add [output] to Display" when running a model in ArcGIS Pro?
This functionality is not currently available at this time.

How do I access the Help library if I decide to work offline?
If you have installed the local Help, choose the Project tab inside ArcGIS Pro. Then choose Options and click General to select the, "Offline help from your computer [requires local help installation]" option.

Why is the Infographics tool grayed out, if I'm logged into my licensing portal?
You must also be signed into arcgis.com to enable Online functionality. To do so, go to the Project Tab and click Portals. Right-click on the arcgis.com portal and choose Sign in. Provide your Online credentials. Sign in.

Does ArcGIS Pro connect to multiple Portals?
Yes. ArcGIS Pro supports multiple portal connections, enabling consuming and sharing of content amongst all portals. One portal is active in the project user interface at any time, but connections to any number of portals may be stored in a project. ArcGIS Online is the default portal for ArcGIS Pro.

Will my Python scripts work in Pro?
ArcGIS Pro uses Python 3; existing Python scripts that use ArcPy will use Python 2. It is possible to write Python that will work in either environment but if you want to migrate existing scripts to Python 3 then some porting may be required. ArcGIS Pro comes with a geoprocessing tool that will analyze and make suggestions for you on what lines of code to edit. There is also a help topic for Python 3 migration.
How do you customize ArcGIS Pro?
ArcGIS Pro supports many ways to customize it. You can easily create, add or remove ribbon tabs and commands in the project options, and these customizations will persist in your project. Another way to customize the user interface is with Tasks, which let you record, save, repeat and share stepwise workflows within and between projects. You can customize the tools available to you in the analysis gallery. Python coding will let you customize behavior like labeling, or create new geoprocessing tools. Finally, Pro will have a .Net API supporting add-ins and extend the functionality of ArcGIS Pro. The new .NET API will be part of ArcGIS Pro 1.1 SDK for .NET

Will my existing Python scripts work in ArcGIS Pro?
It depends. ArcGIS Pro uses Python version 3.4.0. This is a significant change from Python 2.7, and existing Python scripts may need to be altered to run successfully with ArcGIS Pro. See the Python 3 migration topic for more information and strategies. To help smooth the migration process, the Analyze Tools for Pro geoprocessing tool can be used to identify and review potential migration issues in your Python code.

In what languages is ArcGIS Pro available?

In addition to English, Esri will provide localized versions of ArcGIS 10.3.1 in the following 9 languages:

- Arabic
- Brazilian Portuguese
- Chinese (simplified)
- Czech
- Finnish
- French
- German
- Hebrew
- Italian
- Japanese
- Korean
- Russian
- Spanish (neutral)
- Swedish
- Turkish